


List of ComputorEdge Sponsors
San Diego ComputorEdge Sponsors

Colocation and Data Center

redIT

With approaches like smart security, customized colocation and an extensive range of managed
services, redIT helps you intelligently leverage IT.

Computer Store, Full Service

Chips and Memory

New Systems Starting At $299 Visit Our Website or Call for Hardware, Software, Systems, or
Components Laptop*Desktop*Server IT Service * Upgrades * Service Everyday Low Prices

Macintosh Specialists

Maximizers

Serving San Diego County Since 1988 * Onsite Macintosh Service for Home and Small Office
Needs * ACSP: Apple Certified Support Professional ACTC: Apple Certified Technical
Coordinator Apple Consultant's Network

Repair General

Hi-Tech Computers

Notebooks, Monitors, Computers and Printers We Buy Memory, CPU Chips, Monitors and
Hard Drives Windows 7 Upgrades Phone (858) 560-8547

Colorado ComputorEdge Sponsors

August 8, 2014 List of ComputorEdge Sponsors

2

http://webserver.computoredge.com/shopper/sponsor.mvc?ccode=CST8&zone=SD&src=ebook
http://webserver.computoredge.com/shopper/sponsor.mvc?ccode=CMM8&zone=SD&src=ebook
http://webserver.computoredge.com/shopper/sponsor.mvc?ccode=MCZ8&zone=SD&src=ebook
http://webserver.computoredge.com/shopper/sponsor.mvc?ccode=HIT8&zone=SD&src=ebook


ComputorEdge™ Online — 08/08/14
Click to Visit ComputorEdge™ Online on the Web!

Replacing Adobe Reader with
Foxit PDF Reader

Foxit PDF Reader is a good choice for
replacing the bloated and annoying
Adobe Reader

Magazine Summary
List of ComputorEdge Sponsors

Digital Dave
by Digital Dave
Digital Dave answers your tech questions.
Flash Drive Files; LibreOffice AutoCorrect; The Danger in "Doing Links."

FoxIt Reader PDF Reading Software (Free)
by Jack Dunning
Based on Recommendations of ComputorEdge Readers, Foxit PDF Reader Is Now a Favorite
Like so many other de facto standards, Adobe Reader has become bloated and annoying. It's time to replace it
with Foxit PDF Reader.

Packing More Info into Apps with Window Tabs
by Jack Dunning
The AutoHotkey Tab GUI Control Is a Powerful Space Saver for Windows Apps
When you find that you are adding so many data and editing fields to your AutoHotkey GUI windows that they
become large and grotesque, then it's time to take a look at the Tab control. Tabs instantly add more space to
your apps without taking up more screen.

Wally Wang's Apple Farm
by Wally Wang

August 8, 2014 ComputorEdge™ Online — 08/08/14

3

http://webserver.computoredge.com/online.mvc?src=ebook


Apple Moving to the Enterprise
Apple Moving to the Enterprise; Open Source Wins Again; Turning an iPad Into a Whiteboard; Adware Comes
to the Macintosh; Technology is Never a Magic Bullet; Following iBeacon; Erase Deleted Items.

Editor's Letters: Tips and Thoughts from Readers
by ComputorEdge Staff
Computer and Internet tips, plus comments on the articles and columns.
"Microsoft Windows Update," "Open vs. LibreOffice," "Win 8 Upgrade and Internet Access"

Send mail to ceeditor@computoredge.com with questions about editorial content.
Send mail to webmaster@computoredge.com with questions or comments about this Web site.

Copyright © 1997-2014 The Byte Buyer, Inc.

ComputorEdge Magazine, P.O. Box 83086, San Diego, CA 92138. (858) 484-1998

Click to Visit ComputorEdge™ Online on the Web!

August 8, 2014 Magazine Summary

4

http://webserver.computoredge.com/online.mvc?src=ebook


Digital Dave
“Digital Dave answers your tech questions.” by Digital Dave

Flash Drive Files; LibreOffice AutoCorrect; The Danger in "Doing Links."

Flash Drive Files
Dear Digital Dave,

I'm sure this is a Mickey Mouse question for the experts, but I am not one. I have just loaded
a 16GB flash drive with some photos. It shows that I have 5.36GB free space remaining. If I
want to add additional photos or anything else, will it write over my existing photos, or will
the new data begin where the old left off?

Thanks in advance for your assistance and information.
Gabby DeDonato
San Clemente, CA

Dear Gabby,

Even though a flash drive has no moving parts, it interacts with a computer the same way as a
hard drive. It contains an internal directory which tracks all of the files you have loaded onto
it. Therefore, the files will not be overwritten unless you first delete them. You should be able
to continue to add files to the drive until it is full.

In fact, for flash drives (or Secure Digital cards in cameras) it is probably best to let the chip
continue to fill up until you need more space, then clear off all of the unneeded files. The
reason for this is whenever there is an erasure of a bit, a small amount of deterioration occurs.
This is multiplied by the sequence a flash drive uses to delete files. Limiting how often you
erase files will limit this multiplier effect. I haven't done the math to prove this, but there is
certainly no harm in leaving files in place until you are forced to remove them.

This theory of mine does not apply to Solid State Drives since the files will be moved from
time to time to more efficiently spread the use of all the memory—even if the files never
change.
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Files are not actually deleted from any drive when you press Delete—even after emptying the
trash. They are merely marked as deleted in the directory and no longer appear on your list of
files. This tells the system that the space they occupied is now available for writing, but until
something else is written to the drive which overwrites that space, there are ways to recover
the files.

Getting back to your original question, if you can see the files in your folder list, then they are
highly unlikely to be overwritten.

Digital Dave

LibreOffice AutoCorrect
Dear Digital Dave,

LibreOffice is a favorite of many, yet there are numerous complaints about the difficulty
with getting the Auto Correct to function. In every update I have done it does not work! A
Google search reveals that this is common. What is the easiest way to get it working and is
there anything professionals like you can do to get the sponsors to correct their recurring
problem?
Ron
Austin, TX

Dear Ron,

It appears that losing Autocorrect is a common problem with updates of LibreOffice.
Assuming that you have all the proper settings (Format => AutoCorrect => While Typing),
the answer to getting it going again is deleting some folders which are automatically set up
when launching LibreOffice.

Close LibreOffice. Open the Applications folder (Run => shell:appdata). Open the
LibreOffice folder. At that level, delete any folder starting with "4" and the subfolder. Restart
LibreOffice. According to others this should do the trick.

I'm sure that this problem is on the list for the LibreOffice support group. I just don't know its
priority. Since the software is free, there is little that anyone can do until the people in charge
think that there is nothing more important to do. That day will come. I just don't know when.

I have AutoCorrect turned off in LibreOffice because I don't want it to interfere with my
AutoHotkey AutoCorrect. The reason I use AutoHotkey for AutoCorrection is because it
works in every Windows program I use, whether it's e-mail, a Blog, a text document, or any
other time I'm typing text. There may be a few more features in the LibreOffice AutoCorrect
such as automatic capitalization of the first letter after a period, but I can live without that—
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even though I had to learn how to use the SHIFT key to start a sentence.

Digital Dave

The Danger in "Doing Links"
Dear Digital Dave,

When I send a link to a friend by e-mail, he replies, "I don't do links." I understand what he's
saying, but I think he's being more superstitious than wise. Just being online is "doing
links." Granted, you don't want to download from suspect sources or open attachments that
are suspect, but to make a blank policy of not connecting to strange links—isn't that going
overboard?
Garry Schaeffer
San Diego, CA

Dear Garry,

The technical term for fear of clicking links is portaphobia (the fear of entrances). Not unlike
agoraphobia (the fear of being outside—especially in crowds), portaphobia traps the computer
user inside the walls of the computer. Yes, it is excessive if someone actually never clicks
links. I wonder how your friend feels about e-mail attachments.

I believe in being cautious, but clicking links is not the most dangerous thing that you can do.
Unless you have removed all security from your computer, even a bad link is not likely to do
much more than take you somewhere you probably don't want to go. Cancelling everything
will generally undo the excursion. If the link tries to download something onto your computer,
there is usually a warning that will give you the opportunity to stop it. The people who get in
trouble are those who ignore the warnings.

If I get an unexpected link or attachment from a friend, I generally query the sender for
validation. (There is malware that can make an e-mail look like it's from a friend.) If the
response is positive, then I venture forward.

It comes down to trust. Only click links from trusted sources. A person you know personally is
generally a good example of either a trusted source of links or somebody whose links you
know for sure are absolutely not safe. Use judgment. Zero tolerance is rarely appropriate.

If your friend won't click a link, the problem now is how do you get the important information
to him? The data package is obviously too big for an attachment (which he probably wouldn't
open anyway). I suppose you could print it and put it in a letter (if you can find a stamp). Or,
better yet, post it on Facebook—unless he doesn't do Facebook either. It has links. Humm.
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Digital Dave
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FoxIt Reader PDF Reading Software (Free)
“Based on Recommendations of ComputorEdge Readers, Foxit PDF Reader Is Now a

Favorite” by Jack Dunning
Like so many other de facto standards, Adobe Reader has become bloated and annoying. It's time to
replace it with Foxit PDF Reader.

A couple of weeks ago, I was remiss in not including Foxit PDF Reader in the article about the
free software I actually use. I replaced Adobe Reader with Foxit a while back. Sometimes I get
so used to using a good product that I forget that it's even there. I found Foxit PDF Reader
through the wise recommendations of ComputorEdge readers. Sometime ago, I finally got
around to installing it and giving it a try. I liked it so much that whenever I do an update on the
book Jack's Favorite Free Windows Programs, I will include a chapter on it. I certainly think
it is worth the time to recommend it to all ComputorEdge readers.

Foxit PDF Reader is such a good replacement for Adobe Reader that I recommend anyone still
using Adobe Reader uninstall it completely and add Foxit to their Windows systems. While
both programs are free, when compared to Foxit, Adobe Reader is a pig.

Why Not Adobe Reader?
Adobe invented the PDF (Portable Document Format) and Adobe Reader has been the king of
the free PDF file reading software for decades (not unlike what Internet Explorer was in Web
browsers). However, the software became more and more bloated over years, slowing down
computers and annoying people with constant updates. All that most people really need was a
light, fast PDF reader which doesn't hog memory.

It doesn't take much searching to find numerous comments about Adobe Reader such as,
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"Constant and bothersome updates plus huge footprint make Adobe Reader my least favorite
PDF tool," and "Resource hog, unstable, bloated and highly insecure."

Both Google Chrome and Mozilla Firefox have their own light PDF reader built into their
browser which has eliminated much of the need for Adobe Reader. However, there are times
when you want to do more with a PDF file, plus it's nice to have a program not depended
upon loading a Web browser. This is where Foxit PDF Reader comes in.

Foxit PDF Reader
There are many free PDF readers available, but few of them have received the recognition of
Foxit PDF Reader for its speed and capabilities. In addition to reading PDFs, Foxit allows the
user to add comments directly to the PDF, fill in forms, and even has a limited feature for
creating new PDFs from files, a scanner, or the Windows Clipboard.

The interface is intuitive with a ribbon toolbar system (see Figure1), but if you hate ribbon
menus, you can set Foxit to the Classic Toolbar dropdown menu mode.
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Figure 1. The default mode for Foxit PDF Reader is a ribbon toolbar, but it can be changed to the dropdown menu style.

Most of the controls are intuitive. By testing the buttons while moving from tab to tab, you'll
quickly understand what each does.

Adding Comments and Your Stamp of Approval
If you need to collaborate with others on a particular PDF, then there is a multitude of ways to
add comments to the document (see Figure 2).
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Figure 2. Comments can be added to PDF documents by selecting from the various options. Here the cover image is
circled with an arrow pointing at it, plus a note box and "Approved" stamp.

There is even a set of preformatted stamps which include "Approved," "Completed,"
"Confidential," "Draft," "Emergency," "Expired," "Received," and many more. What's really
cool is that you can make your own stamps from any graphic images (a happy face?).

This commenting capability is especially useful in working environments where a number of
people must review a file before corrections are made on the original…or maybe you just want
to highlight certain aspects of a document you're e-mailing to a friend.

The View tab offers various ways to reformat the PDF format for display. If you want to
temporarily eliminate all the images for easier reading, click the Text Viewer button (see Figure
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3).

Figure 3. To convert the file to text only, click the Text Viewer button in the View tab (circled with arrow).

If you want the document read to you, click the little speaker icon in the View tab (see Figure
4). The computer's voice is used to read all of the text out loud—useful for the visually
impaired and very young children.
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Figure 4. Foxit PDF Reader even has a feature for reading the text in a file with the computer's voice.

The home tab includes options for creating PDF files. For me this is a limited feature.

Creating New PDF Files
I say that the Foxit Reader PDF creation feature is limited in primarily because you need
Microsoft Office installed to take maximum advantage of it. Since I'm not caught up in the
Microsoft Office collective, that doesn't work for me. I don't have Office installed on any of
my computers—although I may have an old copy of Microsoft Office lying around
somewhere. However, I can still make PDFs from images and text files. Plus, there is a
rudimentary capability to make a blank PDF and add text and images.

Quite frankly, there are so many other ways to create a PDF that using Foxit is more of an
afterthought. Most programs such as OpenOffice and LibreOffice have the capability to
convert documents to PDFs. All of my computers include a print option to save a file as a
PDF. All I have to do is use the print option is any program to access the PDF file driver.

There was a time when I used Adobe Acrobat to make the PDF files for the weekly issue of
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ComputorEdge, but I've found that the free Calibre e-book management software does an
excellent job of creating a PDF file from the EPUB file I generate with the ComputorEdge
online program. I rarely load my old, clumsy copy of Adobe Acrobat anymore.

Using Foxit in Google Chrome and Mozilla Firefox
While Foxit is a standalone program, there is a plug-in for Chrome and Firefox which allows
you to read a PDF in those Web browsers. It replaces the built in PDF reader in each. The
advantage to using this browser plug-in is that you get a similar look and feel to the main
program and most of the same features—including reading out loud. (As far as I know Internet
Explorer does not use add-ons to read PDFs. You can set the default browser to Foxit, but
when viewing a PDF the main Foxit program will open for viewing independently of Internet
Explorer.)

Getting the Foxit plug-in to work with these Web browser can be a little tricky. When installing
the Foxit program, indicate that you want to use the Web browser plug-in. Then in Google
Chrome open the Plug-ins page (see Figure 5). (Enter chrome//:plugins into the address field
at the top of the window.)
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Figure 5. To enable the Foxit PDF Reader plug-in in Google Chrome, open the Plug-ins page, disable Chrome PDF
Viewer and Adobe Reader (if you still have it), and enable Foxit Reader for Mozilla (red arrow).

Find Foxit Reader Plug-in for Mozilla and Enable it. If you don't see it you may need to
reinstall the Foxit package or you can download the Foxit add-ons package directly from Foxit
Software.

Enabling the plug-in for Firefox is a two step process. First set the Foxit plug-in to Always
Active in the Plug-ins screen (Tools => Add-ons or enter about:addons in the address field)
(see Figure 6).
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Figure 6. Open the Add-ons page in Firefox and set Foxit Reader Plug-in for Mozilla to Always Activate.

Next open the Applications tab in the Tools => Options menu and select Portable Document
Format (PDF) from the list (see Figure 7). Click the arrow at the right select Use Foxit Reader
Plug-in for Mozilla (see Figure 7).
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Figure 7. Set Firefox to use the Foxit plug-in.

I found that procedure it was a little more problematic in Windows 8.1. For some reason the
plug-in never appeared in the Applications list even though it was installed. I was able to select
the main Foxit program which loads PDF externally to the browser into the standalone
program.

Another reason for making Foxit as your default PDF reader in Windows 8 is because of a
problem caused by the PDF Reader app in the Modern interface. Apparently, the last file
opened by the Modern reader gets locked and stays locked—even if the reader is closed. The
reader needed to be stopped in Task Manager to release the file lock. Otherwise, the file can't
be opened, edited, or deleted by any other program.

I can't say the Foxit PDF Reader is the best program available because I haven't tried them all,
but it is certainly a good one and better than sticking with Adobe Reader. Some people
recommended Nitro Reader which can also create PDFs from files, but doesn't require
Microsoft Office to be installed. If all you do is occasionally read a PDF in Chrome or Firefox,
then sticking with the built-in reader is probably good enough. But if you want to do even a
tiny bit more or use Internet Explorer, get Foxit PDF Reader.
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Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first
issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is
www.computoredge.com. He can be reached at ceeditor@computoredge.com. Jack is now in
the process of updating and compiling his hundreds of articles and columns into e-books.
Currently available:

Recently released is Jack's FREE AutoHotkey book, AutoHotkey Tricks You Ought to Do
with Window, available exclusively at ComputorEdge E-Books in the EPUB for e-readers and
tablets, MOBI for Kindle, and PDF for printing formats.

ComputorEdge E-books offering is his AutoHotkey Applications, an idea-generating
intermediate level e-book about using the AutoHotkey Graphical User Interface (GUI)
command to write practical pop-up apps for your Windows computer. (It's not as hard as it
sounds.)

Hidden Windows Tools for Protecting, Problem Solving and Troubleshooting Windows 8,
Windows 7, Windows Vista, and Windows XP Computers.

Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software
Ever!: Create Power Tools for Windows XP, Windows Vista, Windows 7 and Windows 8 and
Digging Deeper Into AutoHotkey.

Our second compilation of stupid ComputorEdge cartoons from 2011 and 2012 is now
available at Amazon! That Does Not Compute, Too! ComputorEdge Cartoons, Volume II:
"Do You Like Windows 8 or Would You Prefer an Apple?"

Special Free Offer at ComputorEdge E-Books! Jack's Favorite Free Windows Programs:
What They Are, What They Do, and How to Get Started!.

Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8
(Seventh Edition)!

Windows 7 Secrets Four-in-One E-Book Bundle,
Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using
Windows 7,
Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7,
and That Does Not Compute!, brilliantly drawn cartoons by Jim Whiting for really stupid gags
by Jack about computers and the people who use them.
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Packing More
Info into Apps
with Window
Tabs
“The AutoHotkey Tab GUI

Control Is a Powerful Space Saver for Windows Apps” by Jack Dunning
When you find that you are adding so many data and editing fields to your AutoHotkey GUI windows
that they become large and grotesque, then it's time to take a look at the Tab control. Tabs instantly add
more space to your apps without taking up more screen.

I took up working on the Calorie Counting script again last week. I keep finding issues and
bugs. (An issue is something that works, but I would prefer that it work a different way. A bug
is something which doesn't work properly.) As I encounter these, I add them to my list of
things to do. Each item has a specific AutoHotkey learning point and I plan to cover them in
the coming weeks. Understanding what's involved in in these situations helps in future script
writing and debugging.

As I have stated before, a script is never truly finished. There is always something more that
either needs to be fixed or would be nice to include. In the past, I've concentrated on getting a
rudimentary example script working and left the completion up to the reader. This time I will
spend more time with the Calorie Counting script adding features and fixing bugs. If you want
a truly useful end product, then this testing and repair is part of the process. Every software
program needs to go through this debugging stage (except maybe some of the one-line
AutoHotkey hotkeys and hotstring replacement scripts). If you happen to test the current
version of CalorieCount.ahk and find any bugs or have any comments, then please let me
know. I may not include all the recommendations, but I will certainly try to fix the bugs. I will
explain each issue through this column and how I resolved (or failed to resolve) it. This file can
be found at the ComputorEdge AutoHotkey download site.

Some of this detail may be a bit much for beginning AutoHotkey script writers, but hang in
there. Like any language it takes a little time to become fluent. (If you haven't gotten started
with AutoHotkey yet (and you should—it's good for your brain), see our Introduction to
AutoHotkey!)

The GUI (Graphic User Interface) Tab Control
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The GUI (Graphic User Interface) Tab control adds space to an AutoHotkey window without
adding any space. In other words, the tab gives more operating area without taking up more of
the screen. Add one tab and the working space is doubled. Add two tabs and the available
window size is effectively tripled without changing its height or width. I added an entirely new
table of previously entered food items to the CalorieCount script by using the Tab control.

Originally, the CalorieCount app was just one window where daily calories were looked up
and entered. (Imagine Figure 1 without the tabs at the top.) However, I wanted to add a
history so that food items already entered into the system could be reused. This would save
new Web lookups and/or searching through previous days in the log to copy entries.

Figure 1. The original CalorieCount app was one window without the tabs located at the top.

The problem was that another list could take up substantial space making the window far too
large. The solution was to add a Tab GUI control. Changing to the other tab opens a clear
space of the same size as the window—in this case the Food List shown in Figure 2.
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Figure 2. Using the Tab control the effective window space is doubled for adding the food history. Click each tab to
change the view.

There could just as easily be three, four, or more tabs in the window, so it's easy to see how a
great deal of additional space can be generated for almost any AutoHotkey app. The Tab
control used in the CalorieCount script is as follows:

Gui, Add, Tab2, w600 h450 gTabClick vTabNum altsubmit, Daily Calories | Food List

(Note: The Tab2 control was introduced to correct some problems in the original Tab control.
If the script does not run properly on your Windows computer, then you may need to upgrade
to a more recent version of AutoHotkey. See the AutoHotkey documentation for more
details.)

The number of tabs is designated by the number of names separated by the vertical line "|"
character at the end of the code line. In this case there are only two with the names Daily
Calories and Food List. Want more tabs? Add more names separated by the vertical line "|"
character.
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After the Gui, Show command, the window pops up, as shown above, but before any controls
are added to a tab it appears as a blank area completely covering the window. Click a tab to
switch between areas.

The Tab control creates an outline which includes both the tabs and a designated area of the
window, in this case w600 h450 specifies the dimensions of the tab box. Even though selecting
a tab completely clears the entire window for use, this box outline is the actual size of the
control for layout purpose. (The space outside the box can be used for other controls.) The
Tab box works in a manner very similar to the GroupBox control.. (For more information on
the GroupBox control, see "Using the GroupBox GUI Control" in this other AutoHotkey
column.)

Tip: If you want certain controls to appear on every tab area, use the Gui, Tab command with
no parameters before adding the controls. The controls will then be place at the same spot and
be visible on all tabs.

Just as with the GroupBox, the best positioning options to use when placing controls inside the
Tab box are xp± and yp±—which locate the control relative to the upper left-hand corner of
the previous control. If all the controls are placed in this manner then they get locked in as a
group and only the first control needs repositioning to move the entire group. (Even I get
confused by the position controls and need to refer to the sizing and positioning documentation
whenever I start doing something that's even a little tricky.)

Switching Tabs
Switching tabs is as easy as clicking a tab (or using CTRL+PageUp or CTRL+PageDown on
the keyboard). The problem comes in when a control such as ListView needs to be activated
when its respective tab is clicked. That's the issue in the CalorieCount script. Interaction with
a ListView only occurs with the last active control. The proper ListView must be activated
when the appropriate tab is selected. That's the reason for adding the label (subroutine)
gTabClick and the variable vTabNum options to the Gui, Add, Tab2 line. The AltSubmit
option is added so that the variable TabNum will save the number value of the tab rather than
its name.

Whenever a tab is clicked the following glabel subroutine runs:

TabClick:
  Gui, Submit, NoHide

  If TabNum = 1
    Gui, ListView, MyListView

  If TabNum = 2
    Gui, ListView, MyFoodView
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Return

The Gui, Submit line is important for storing the current tab number to the variable TabNum.
Otherwise the value will not change. (Omitting the Gui, Submit command is a common error
in beginning scripts. Leave it out and the script will try to send data to the wrong control—
even though the tab has changed.) The NoHide parameter is important for preventing the GUI
window from closing after the tab is clicked. Very aggravating!

Depending upon the tab number clicked, the active ListView is set to either Gui, ListView,
MyListView or Gui, ListView, MyFoodView—which is that standard method for activating a
particular ListView. This takes care of activating the proper ListView whenever a specific tab
is selected.

Adding Controls to Another Tab
So far controls have only been added only to the first tab. Now it's time to place the new
ListView in the second tab area:

Gui, Tab, 2
Gui, Add, ListView, xs y+18 section sort r22 w200 vMyFoodView, Food  
     | Serving Size | Cal/Serv  ;gMyFoodview

The second tab is selected for adding controls with the Gui, Tab, 2 command. (This is similar
to the Gui, Tab command mentioned in the tip for displaying a control on all tabs, except there
is a tab number included as a parameter.) For the purpose of adding more controls, the script
has switched to tab two—any following controls will be added to the second tab until another
Gui, Tab command is issued. If you have more tabs, selecting the appropriate tab for loading
controls is as easy as changing the number in the last parameter.

In many ways, the Tab command makes it much easier to add features and power to your
AutoHotkey apps. Many people don't use tabs because they appear to complicate things, but
they are simple to implement and save you from building larger or separate GUI windows to
add needed tools to your script. If you have more features that you want to add to your
favorite script, consider using the Tab command.

Next time, I'll talk about changes in the script for adding data to the new ListView which
resides in the new tab and how to make at interact with the data fields in the Daily Calories
tab.

*                    *                    *

Recently released and free from ComputorEdge E-Books! AutoHotkey Tricks You Ought To
Do With Windows! This e-book includes both those tips and the reference material (Table of
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Contents and indexes) from the other three AutoHotkey books below. Pick up a copy free and
share it with your friends.

*                    *                    *

The second edition with more chapters and an index to the
AutoHotkey commands found in the book is available in e-book
format from Amazon (and other formats—EPUB and PDF— at
the ComputorEdgeBooks Web site linked below). Jack's A
Beginner's Guide to AutoHotkey, Absolutely the Best Free
Windows Utility Software Ever!: Create Power Tools for
Windows XP, Windows Vista, Windows 7 and Windows 8
(preferred, EPUB format for iPad, Android, and computers;
MOBI for Amazon Kindle; and PDF for printing) offers a gentle
approach to learning AutoHotkey. (Also available from Amazon
for the Kindle and Kindle software on other devices.)

Building Power Tools for Windows XP, Windows Vista,
Windows 7 and Windows 8, AutoHotkey is the most powerful, flexible, free Windows utility
software available. Anyone can instantly add more of the functions that they want in all of
their Windows programs, whether installed on their computer or while working on the Web.
AutoHotkey has a universality not found in any other Windows utility—free or paid.

Based upon the series of articles in ComputorEdge, Jack takes you through his learning
experience as he explores writing simple AutoHotkey scripts for adding repetitive text in any
program or on the Web, running programs with special hotkeys or gadgets, manipulating the
size and screen location of windows, making any window always-on-top, copying and moving
files, and much more. Each chapter builds on the previous chapters.

For an EPUB (iPad, NOOK, etc.) version of A Beginner's Guide to AutoHotkey click here!

For a PDF version for printing on letter size paper for inclusion in a standard notebook of A
Beginner's Guide to AutoHotkey click here!

*                    *                    *
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Jack's second AutoHotkey book, Digging Deeper Into
AutoHotkey (preferred, EPUB format for iPad, Android, and
computers; MOBI for Amazon Kindle; and PDF for printing) is
comprised of updated, reorganized and indexed columns from
ComputorEdge is now available. Since the columns were not all
written in a linear fashion, the book has been reorganized and
broken up into parts by topic. The book is not for the complete
beginner since it builds on the information in A Beginner's Guide
to AutoHotkey. However, if a person is reasonably computer
literate, they could go directly to this book for ideas and
techniques without the first book. (Also available from Amazon
for the Kindle and Kindle software on other devices.)

For an EPUB (iPad, NOOK, etc.) version of Digging Deeper into AutoHotkey click here!

For a PDF version for printing on letter size paper for inclusion in a standard notebook of
Digging Deeper into AutoHotkey click here!

*                    *                    *

Jack's third AutoHotkey book AutoHotkey Applications
(preferred, EPUB format for iPad, Android, and computers;
MOBI for Amazon Kindle; and PDF for printing) is an
intermediate level book of ideas and applications based primarily
on the AutoHotkey GUI command. The book emphasizes
practical applications. The book is not for the complete beginner
since it builds on the information in the other two books.
However, if a person is reasonably computer literate, they could
go directly to this book for ideas and techniques without the other
books. There is an extensive index to the ideas and techniques
covered in the back of the book. (Also available from Amazon
for the Kindle and Kindle software on other devices.)

For an EPUB (iPad, NOOK, etc.) version of AutoHotkey Applications click here!

For a PDF version for printing on letter size paper for inclusion in a standard notebook of
AutoHotkey Applications click here!

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first
issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is
www.computoredge.com. He can be reached at ceeditor@computoredge.com. Jack is now in
the process of updating and compiling his hundreds of articles and columns into e-books.
Currently available:
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Recently released is Jack's FREE AutoHotkey book, AutoHotkey Tricks You Ought to Do
with Window, available exclusively at ComputorEdge E-Books in the EPUB for e-readers and
tablets, MOBI for Kindle, and PDF for printing formats.

ComputorEdge E-books offering is his AutoHotkey Applications, an idea-generating
intermediate level e-book about using the AutoHotkey Graphical User Interface (GUI)
command to write practical pop-up apps for your Windows computer. (It's not as hard as it
sounds.)

Hidden Windows Tools for Protecting, Problem Solving and Troubleshooting Windows 8,
Windows 7, Windows Vista, and Windows XP Computers.

Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software
Ever!: Create Power Tools for Windows XP, Windows Vista, Windows 7 and Windows 8 and
Digging Deeper Into AutoHotkey.

Our second compilation of stupid ComputorEdge cartoons from 2011 and 2012 is now
available at Amazon! That Does Not Compute, Too! ComputorEdge Cartoons, Volume II:
"Do You Like Windows 8 or Would You Prefer an Apple?"

Special Free Offer at ComputorEdge E-Books! Jack's Favorite Free Windows Programs:
What They Are, What They Do, and How to Get Started!.

Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8
(Seventh Edition)!

Windows 7 Secrets Four-in-One E-Book Bundle,
Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using
Windows 7,
Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7,
and That Does Not Compute!, brilliantly drawn cartoons by Jim Whiting for really stupid gags
by Jack about computers and the people who use them.
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Wally Wang's Apple Farm
“Apple Moving to the Enterprise” by Wally Wang

Apple Moving to the Enterprise; Open Source Wins Again; Turning an iPad Into a Whiteboard; Adware
Comes to the Macintosh; Technology is Never a Magic Bullet; Following iBeacon; Erase Deleted Items.

With iPad sales declining among consumers, Apple's next growth market involves
corporations. Already 92 percent of Fortune 500 companies are testing the iPad. While
Android and Windows tablets offer some competition, the bulk of tablet sales still remain with
Apple, which likely means a larger market for apps aimed specifically for the corporate
market. IBM's latest deal with Apple plans to focus on corporate apps so you can bet IBM will
help make the iPad a corporate standard.

In the not so distant past, corporations relied on Blackberry smartphones. Now Ford plans to
dump Blackberry in favor of giving their employees iPhones. The iPhone and iPad are already
favorites with the corporate crowd, so it's only a matter of time before more Macintosh
computers start slipping into the corporate world as well.

While the Macintosh still remains far behind Windows PCs in the corporate world, the gradual
growth of Macintosh sales means a steady increase of Macintosh computers in corporations
over time. eWeek (formerly called PC Week) even listed ten reasons for why a MacBook Air
might be right for corporate use.

Just a few years ago, eWeek rarely mentioned Apple products at all. Now in the absence of
interesting news and products from the traditional Windows PC world, eWeek has focused
more on Apple products working their way into the corporate market.

When Apple introduced FaceTime, they focused mostly on one to one contact between
friends. To encourage corporate use of FaceTime, Apple has patented a multi-view camera
system that allows multiple people in a conference room to use FaceTime to conduct video
meetings.
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Figure 1. Apple patented a multiple camera FaceTime device for meetings.

For years, the corporate world has clung to the Windows PC and Blackberry as corporate
"standards." Today the iPhone, iPad, and Macintosh are making steady inroads into the
corporate market with no slowing in sight. As Blackberries fade away and Windows PC sales
remain stagnant, it's clear that the corporate world is embracing more Apple products than ever
before.

For anyone who still thinks Apple products are only toys, you can ask all those mainframe and
minicomputer enthusiasts who thought the same thing about early PCs. When mainframe and
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minicomputer enthusiasts derided PCs as toys, we all know how corporations never embraced
PCs to do any type of productive work at all.

Open Source Wins Again
Former Microsoft CEO, Steve Ballmer, once called Linux a cancer. Since then, Microsoft has
slowly embraced more open source projects and backed away from their earlier inflammatory
comments about open source projects like Linux.

Apple's own OS X is based on the open source operating system FreeBSD while Apple also
contributes to the open source project WebKit, which powers the Safari browser. Clearly
Steve Ballmer felt threatened by open source projects like Linux and LibreOffice that
undermined the reasons to pay money for Windows and Microsoft Office.

For the ultimate open source project, download the source code to Open Worm, a project that
seeks to duplicate digital life. By mimicking the parts of the C. elegans nematode worm as a
digital life form, the Open Worm project hopes to encourage scientists and enthusiasts to study
how changes in one part of a life form can affect different parts of an animal.

A similar open source project is geppetto, a neuroscience simulator. Now you can study the
brain and nerves to better understand how the brain works without having to dissect or kill
anything.

Figure 2. The geppetto project lets you study molecular biology as a digital simulation.
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If you're interested in studying biology using a computer, then take a look at the Open Worm
and geppetto open source projects. For anyone looking for a job in the computer or biology
field, there's no better way to spice up your resumé than by contributing to an open source
project like Open Worm or geppetto.

Turning an iPad Into a Whiteboard
One of the reasons why the iPad has caught the imagination of so many people (except for
critics who can't recognize innovation right in front of their face) is its versatility. The iPad
screen can turn into a game, a word processor, or a slideshow presentation screen. To see how
corporations have found ways to save time and money using an iPad, just browse through
these stories so you can see for yourself how an iPad can be useful in the business world.

If you're the type of person who likes organizing your thoughts using sticky notes on a
whiteboard, you can now turn your iPad into a whiteboard using the Stickyboard app.

Figure 3. Stickyboard mimics posting sticky notes on a whiteboard.

Just create a virtual sticky note on the screen using colors to organize related ideas, then move
them on the screen. If you connect your iPad to a larger screen, you can collaborate with
others while manipulating ideas on the iPad.

You may not want to buy an iPad just to use an app like Stickyboard, but once you have an
iPad, apps like Stickyboard simply make the iPad more useful and flexible for both
entertainment and work. Try creating and manipulating sticky notes on a real whiteboard and
then try sharing your final organized notes with others so they can modify it on their own
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without messing up your original organization. Then try creating and manipulating ideas on a
laptop and see how a physical keyboard isn't always an advantage.

Figure 4. Stickyboard makes it easy to manipulate and rearrange your notes.

If you need to brainstorm ideas by yourself or with others, take a look at Stickyboard and see
if it might simplify your brainstorming tasks. If you're still not convinced that an iPad can help
you work more efficiently, then perhaps you need a brainstorming tool like Stickyboard to help
clarify your thinking.

Adware Comes to the Macintosh
While the vast majority of malware infects Windows PCs, the growing popularity of the
Macintosh means that many malicious programmers are now trying to infect Macintosh
computers with adware, often by poisoning downloads that entice people to open them on
their Macintosh.

If your Macintosh suddenly seems to display ads on the screen or in different browser
windows for no reason, chances are good your Macintosh is infected with adware.
Fortunately, the problem is relatively easy to solve. Just visit the Safe Mac site and download
their free Adware Removal Tool. In case you're suspicious about letting a strange program
probe around your Macintosh, just download a free technical guide that explains how you can
find and remove adware yourself.

If you find the Safe Mac site helpful, consider making a donation to support their adware
removal tools. As always, the weakest link in any security involves people, so be careful what
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you download and where you get it from. If you're busy downloading free games, music,
movies, or programs, there's a high risk of getting any computer infected.

Technology is Never a Magic Bullet
If you want to know why kids don't take school seriously, it's because they see so many poor
role models. In too many school districts, administrators cheerfully waste money on equipment
that never solves the real problem of improving education.

In Hoboken, New Jersey, school administrators came up with the brilliant idea of giving every
student a laptop. While this may sound like a good idea, it avoids the real question of how the
school thought that laptops would improve education. After a five year experiment with Dell
netbooks, the school district wound up locking most of the netbooks in a closet with plans to
pay a recycling firm to help them throw the netbooks away.

One huge problem with netbooks running Windows was that "Licenses for the security
software alone were running more than $100,000 and needed to be renewed every two years."

The school district also discovered that their $500 laptops lasted only two years before needing
to be replaced. Even then the netbooks were underpowered. Only after they purchased the
netbooks did they realize that the educational software they needed to run on the netbooks
would have required a $1,000 laptop instead.

For anyone who thinks price is the overriding criteria for buying a computer, you can save
money buying an inexpensive laptop, only to spend more money replacing it a few years later.
Or you can buy a quality laptop right from the start that will last much longer and cost less per
year in the long run. For short-sighted people, the lowest price is their only criteria except
when it comes to paying extra for security software subscriptions, Microsoft Office
subscriptions, and utility software to keep Windows running properly.

Why do schools waste so much money chasing after technological solutions when those
solutions consistently fail to provide dramatic increases in education? When school districts are
too dense to realize technology of any kind won't magically solve their problems, it's easy to
see how students can get disillusioned attending schools run by so many incompetent
administrators.

Following iBeacon
While critics complain that Apple hasn't released anything innovative since the iPad (and even
then they complained that the iPad wasn't innovative until they later decided that it was),
Apple has released plenty of innovative technology that has slipped past most people's minds.
One blatant example of this is iBeacon.
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The main idea behind iBeacon is for short-range location sensing in public places like retail
stores, museums, and airport terminals. By using iBeacon on your iPhone or iPad, you can get
information from nearby iBeacon sensors.

Stores could use iBeacon to track potential customers and send them custom advertisements to
track which ads statistically bring in the most customers and generate the most sales. Museums
could use iBeacon to provide information about exhibits as people stand in front of them.
Airport terminals could use iBeacon to help travelers find their way to rest rooms, restaurants,
baggage claims, and gates for outgoing flights. Even many sports stadiums are adopting
iBeacon to enhance the experience of attendees.

To learn more about the many uses for iBeacon, visit the iBeacon Insider site. By reading
about so many different uses for iBeacon, you can get a better idea how iBeacon might be
useful in your line of work.

Figure 5. iBeacon Insider tracks the latest uses for iBeacon.

The next time critics complain that Apple hasn't developed anything innovative, chances are
good that these same critics are both missing true innovation from Apple right in front of their
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eyes while failing to criticize other companies for not producing any type of innovative
technology whatsoever.

iBeacon is a perfect example of innovation that's slipped right past most critics along with
Apple's HealthKit software framework for monitoring health data in real-time, HomeKit for
monitoring devices around a building, the Swift programming language for making
programming easier and more reliable, iOS for defining a touch gesture operating system,
Passbook for storing travel information such as digital tickets, iBooks Author for creating
interactive e-books, Continuity for seamlessly linking iOS and OS X, Siri for popularizing
natural language processing and voice recognition, App Stores for changing the retail software
market, TouchID for popularizing fingerprint recognition sensors, and iTunes University for
bringing education to the public for free.

Can anyone think of any other company that has produced anything that has had the same
impact on the way people live, work, and play as Apple's long list of innovative technologies
that critics routinely dismiss because they can't recognize innovation even when they see it?

*                    *                    *

Each time you delete a message in the Mail program that comes with every Macintosh, the
Mail program simply dumps the deleted message in a special Trash folder so you can retrieve
it again if you wish.

Obviously this takes up space, so if you need to free up space on your Macintosh just to make
sure it runs a little more efficiently, click the Mailbox menu in the Mail program and choose
Erase Deleted Items. Now you'll have a choice of permanently deleting erased messages from
all your accounts or just the account you specify.

In the early days, before Wally became an Internationally renowned comedian, computer
book writer, and generally cool guy, Wally Wang used to hang around The Byte Buyer
dangling participles with Jack Dunning and go to the gym to pump iron with Dan Gookin.

Wally is responsible for the following books:

Microsoft Office 2013 For Dummies

Beginning Programming for Dummies

Beginning Programming All-in-One Reference for Dummies

Breaking Into Acting for Dummies with Larry Garrison

Strategic Entrepreneurism with Jon and Gerald Fisher
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How to Live with a Cat (When You Really Don't Want To)

The Secrets of the Wall Street Stock Traders

Mac Programming For Absolute Beginners

Republican Fairy Tales (Children's Stories the 1% Tell About the Rest of Us)

The Zen of Effortless Selling with Moe Abdou

The 15-Minute Movie Method

Erotophobia (A novel)

Math for the Zombie Apocalypse

How to Write a Great Script with Final Draft 9

How to Write a Great Script with Fade In

The Elements of a Great Script: Star Wars

The Elements of a Great Script: Die Hard

The Element of a Great Script: Back to the Future

The Elements of a Great Script: Rocky

The Elements of a Great Script: It's a Wonderful Life

In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15
Minute Movie Method," finding interesting news stories about cats at his site "Cat Daily
News," giving advice to authors who want to self-publish e-books at his site "The Electronic
Author," and providing the type of advice he wishes someone would have told him when he
was much younger at his personal Web site. Wally can be reached at
wally@computoredge.com or you can follow him on Twitter @wallacewang_com.
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Editor's Letters: Tips and
Thoughts from Readers
“Computer and Internet tips, plus comments on the

articles and columns.” by ComputorEdge Staff
"Microsoft Windows Update," "Open vs. LibreOffice," "Win 8 Upgrade and Internet Access"

Microsoft Windows Update
Last week there was a Microsoft Windows update that installed on 2 Windows 7 professional
computers that apparently caused 1603 errors. Wiki-error.com says Download (Error 1603)
Repair Tool. It's a registry scanner! The trouble is it shows thousands of not relevant errors
that are in all Windows registers! It turned out that in the Windows Control Panel, click
"System and Security", then click "Restore your computer to an earlier time." Restore before
last update got rid of the 1603 error. Microsoft is getting a little sloppy in the updates.

-Walter, San Diego, CA

Open vs. LibreOffice
[Regarding the July 25 Digital Dave column:]

Essentially Openoffice lost any support/updates/maintenance at all for a couple/several years.
This is my understanding of how/why LibreOffice got started, a bunch of folks wanted it to be
continued to be maintained as well as updated (hence the inclusion of .___x MS format
support). OpenOffice then got some support at some point, but at this point, I just recommend
LibreOffice over OpenOffice.

-Rich Ernst, San Diego, CA

Win 8 Upgrade and Internet Access
[Regarding the July 18 Digital Dave column:] Don't know if this might be related but thought
I'd throw it into the discussion just in case.

About a week ago my Win 8.0 HP laptop went through one of its periodic forced Microsoft
Updates. (I haven't tried to upgrade to 8.1.) Immediately after the update Internet Explorer
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wouldn't access the Internet and its troubleshooting routine couldn't find the problem. After an
hour or two of trying to understand and fix the problem I found a huge clue. If I disabled the
Norton firewall, IE worked fine and re-enabling the firewall again caused IE to fail. I contacted
Norton tech support which seemed familiar with the problem and remotely uninstalled and re-
installed my Norton Internet Security software (antivirus, firewall, etc). Everything then
worked fine again. Apparently a Microsoft automatic update to 8.0 is capable of causing
problems with Norton's firewall.

-Ted, Louisville, CO

I just wanted to say thank you and I am going to try the solution. I am going to disabled
Windows firewall and Norton. I just wish if things did not work or fail, a refresh of Windows
8 did not take three to four hours.

-Mr. Carroll Ware, San Diego, CA

ComputorEdge always wants to hear from you, our readers. If you have specific comments
about one of our articles, please click the "Tell us what you think about this article!" link at
the top or bottom of the specific article/column at ComputorEdge.com. Your comments will
be attached to the column and may appear at a later time in the "Editor's Letters" section.If
you want to submit a short "ComputorQuick Review", or yell at us, please e-mail us at
ceeditor@computoredge.com. If you would like to review our recent e-books, please visit
ComputorEdge E-Books.

Send e-mail to ceeditor@computoredge.com with questions about editorial content.
Send mail to cewebmaster@computoredge.com with questions or comments about this Web site.
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